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1. Introduction 
This package has been created for new employees of the Command and Data 
Handling (C&DH) branch of Payload Processing for the International Space Station 
(ISS) at Kennedy Space Center (KSC). However, it also serves as a refresher, when 
needed, for current employees. The intent of is to introduce the employees to the 
types of data retrievals performed by the branch and how to execute them. 
To begin with, there is an overview of C&DH and its functions. The next two sections 
concern the format of data control (Military-Standard 1553) and data telemetry. 
Having a general understanding of these concepts is important in understanding 
projects within the branch.  
The following sections relate to testing with which the branch is involved. The first of 
these sections distinguish which differences between the types of testing are 
relevant to the branch. The next section concerns Project Unique Identifier (PUI) 
Finder, which supplements programs described in the following two sections. These 
are data retrieval programs directly used by the branch in testing, Test, Control, and 
Monitor System (TCMS) and Protocol Analysis and Simulator System 1000 (PASS-
1000). The sections concerning PUI Finder, TCMS, and PASS-1000 are written in a 
step-by-step format for procedures that would be performed by members of the 
branch.  
In the event that further explanation of C&DH, the programs, or their functions is 
necessary, consult the appendix of this document. There references and their 
locations have been provided, along with an acronym list.  
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2. ISS C&DH  

2.1. C&DH 
Command and Data Handling (C&DH) is a distributed computer/data system made 
up of components that allows ground controllers and the crew to interface with and 
control systems and payloads for the ISS. The components are as follows: 
Mulitplexers/Demultiplexers (MDM), MDM Software (SW), Portable Laptop 
Computers, other computers, data buses, Caution & Warning (C&W, the alarm 
system for the ISS to notify ground and crew of off-nominal conditions and crew 
safety hazards) panel, automated payload switch, and payload Ethernet hub 
gateway. 

2.2. General C&DH Functions 
C&DH provides the capability to send commands to Space Station element end 
items. End items include the Remote Power Controller Module (RPCM), valves, 
fans, and many other items. C&DH also provides routing of data across Station 
computers from end items to Users. Users include Portable Computer System (PCS, 
for crew on orbit), and Mission Control Center Houston / Moscow (MCC-H / MCC-M) 
on Earth. Testing of the C&DH system includes data storage and distribution. Test 
Equipment include 1553 monitors (PASS-1000), high density ground recorders for 
ISPR 802.3 data, and Telemetry displays and recorders (TCMS). C&DH 
responsibilities cross all subsystems, since all systems must maintain 
communication.  

2.3. Architecture 
The client-server architecture of C&DH is a hierarchy of a master Bus Controller 
(BC, typical example is a MDM) controlling a Remote Terminal (RT, typical 
examples are MDM, Firmware Controller [FWC], sensors). The distribution system is 
Mil-Std-1553 B data bus architecture, explained in 3. Military-Standard 1553 
protocols. The primary US computers are MDMs. The secondary computers are 
FWCs and are function unique (example RPCM). Some are microprocessor-based; 
some are state machines. Other computers (International Partners [IP], etc) are 
mostly microprocessor based; many are similar to or exactly like MDMs, though 
others have a completely unique platform. 

2.4. MDM  

2.4.1. Control 
The basic architecture has three tiers for hardware and software: control, local, and 
user. The three tiers of control for MDM control: Command & Control (C&C) MDMs, 
Local Bus MDMs/FWCs, and Subsystem MDMs/FWCs.  
Figure 2-1: Three Tiers of MDM Control 
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Figure 2-2: C&DH Architecture 
C&C gets the data around the buses through various functions. They are: 

• Telemetry 
• Display Data (e.g. to PCS) 
• Commands & Data between Processors  
• Collect and distribute C&W 
• Control / monitor audio, video, Command & Tracking (C&T) 
• Acquire / distribute time 
• Execute Automated Procedures 
• Mass Storage Device Management 
On the ISS, for C&C there are three Intel 80386 units: a primary, a backup, and a 
standby or off. They are all resident in U.S. Lab and have 2.2 MIPs and 1 Mbyte 
RAM.  

2.4.2. Components 
There are 2 types of MDMs: Standard Space Station (SS) MDM and Enhanced 
Space Station (ESS) MDM. The function of a SSMDM is to split one stream of data 
into several streams (and vice-versa) and provide the computing power of a 
personal computer. ESSMDM performs the same functions as a SSMDM, but with 
an added math coprocessor and more memory. The MDMs for the ISS are Intel 
386SX machines built by Honeywell; they are unlike orbiter MDMs. Tiers 1 and 2 
MDMs are ESS; Tier 3 MDMs are SS. MDMs have multiple configurations based on 
function. 
Figure 2-3: MDM Component Architecture  

2.4.3. Interfaces 
Bus Interface Adapter (BIA) Interface has the MDM as a RT. It communicates with 
its BC via this card. Data processing is controlled by either an Input/Output Control 
Unit (IOCU) or Enhanced IOCU (EIOCU).  
IOCU and EIOCU interfaces apply respectively to the SS MDMs and ESS MDMs 
and have the main differences between them. The IOCU/EIOCU contains the brains 
for control of the User Application Software, Input/Output (I/O) Backplane (User Card 
interface), SX Backplane (SPD Card Interface), and communication with the BC (via 
BIA card). IOCU/EIOCU Features: 

• 12 MHz/16 MHz Intel 386SX Processor  
• 1.2M/2.2M Instructions per second 
• 1 M Byte of EEPROM 
• Provides Analog to Digital (A/D) conversions 
• Communicates with the Input/Output Card Control 
• Interfaces with BIA Card 
Serial/Parallel Digital (SPD) Interface provides high speed, digital 1553 
communication for two 1553 buses and two serial 485 lines. A parallel port comes 
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standard on the card but not utilized at this time. COTS product provides Bus 
Controller / Remote Terminal capabilities. SPD Interface has a maximum of 32 
devices per bus. Each bus has 2 channels (A and B). Typical use is for station 
hardware with own processors – motor controllers, other MDMs. 
High Rate Data Link (HRDL) Interface provides access for data storage and retrieval 
to the associated MDMs Mass Storage Device (MSD). HRDL also provides access 
to the Payload Network through the Automated Payload Switch (APS). It is part of 
the C&C MDM and P/L MDM Architecture only. 

2.4.4. I/O Cards 
The I/O cards provide an interface to the various sensors and effectors onboard. 
• Low Level Analog (LLA) – sensors  
• High Level Analog (HLA) – sensors  
• Analog Input Output (AIO) – sensors and effectors 
• Discrete Input Output (DIO) – sensors and effectors 
• Solenoid Driver Output (SDO) – effectors  
The uses of I/O (or User) Cards in Table 2-1: I/O Cards Uses. I/O Cards and their 
applications are listed in Table 2-2: I/O Card Applications.  

2.4.5. Software Products 

2.4.5.1. Software Developer Deliverables 
User Application Software (UAS) is executable code for executing its software 
functionality and communicating with its BC/RTs. Pre Positioned Loads (PPLs) are 
software “updates” which are used to change things such as limits, set points, and 
configurations as needed throughout assembly and operations of ISS. Configuration 
Tables / Files are used to determine which RTs are active, which telemetry formats 
to use, or other unique functions. Other software “databases” used with the 
executable code to expedite commanding (ex. load shedding during emergency 
condition). 

2.4.5.2. Honeywell Software 
Honeywell has three main types of software for ISS C&DH:  

• Boot Software for MDM initialization (separate version for Standard versus 
Enhanced) 

• Diagnostic Software for maintaining stored information to determine root cause of 
problems  

• HRDL Software for communication between it’s MSD and processors (for MDMs 
with Mass Storage Devices) 

2.4.6. Memory Map 
The two memory types of MDM Software are: 
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• Electrically Erasable Programmable Read-Only Memory (EEPROM) – Base Load 
used to activate Computer Software Control Interfaces (CSCI). Software changes 
to this area of memory remain after a power cycle, and will be used to reboot the 
system. 

• Dynamic Random Access Memory (DRAM) – Dynamic Memory/Run time 
memory. Software changes made to this area of memory will be lost during a 
power cycle. 

The layout of the Standard MDM Memory Map is Figure 2-4: Standard MDM 
Memory Map. The layout of the Enhanced MDM Memory Map is Figure 2-5: 
Enhanced MDM Memory Map. 

2.4.7. States 
• Startup (MDM is executing it’s boot/UAS software after power up)  
• Primary* (MDM is in control of its RTs) 
• Backup/Secondary* (Will take over if Primary MDM stops communicating)  
• Standby* (Will go to Backup if Backup MDM stops communicating)  
• Failed (MDM may be in a degraded condition)  
• Diagnostics (UAS software not running; MDM received box level errors; only low 

level commands accepted)  
* Some software developers use different terminologies to describe these states. 

2.5. Mass Storage Device 
MSD is a non-volatile device that stores data (300M bytes) with a data transfer rate 
of 4Mbytes/sec, bi-directional; it providers an onboard hard disk drive for storing 
software. It is contained in selected ESSMDMs. 

2.6. PCS 
PCS is the Crew System Interface. Each computer is an IBM ThinkPad 760XD with 
UNIX based platform (Solaris). They have an external floppy, internal CD, and 
removable hard drive. They have COTS and custom software. Graphical displays 
are used for commanding and data display. There is also a C&W display. They 
support file transfers to/from MDMs and utilizes Recon Files (generated from 
Standard Out [STD OUT]). They have Mil-Std-1553 Interface and plug into Portable 
Computer Receptacles (PCRs) in modules. Prior to 5A activation, PCS interfaced 
w/Node MDMs. After 5A activation, PCS began interfacing with C&C MDMs. PCS 
can also interface with PL-MDMs. 

2.7. Orbiter to Station Interface 
Orbiter Interface Unit (OIU) to the ISS C&DH is used for commands and telemetry. It 
operates as a ‘Bent-Pipe’ / translator. It was the US controller prior to Node-1 MDM 
initiation on 2A. Controller interface is for Ultra High Frequency (UHF) Space to 
Space Communication System (SSCS). On-orbit/pre-assembly Interface (I/F) to 
activate the Multi-Purpose Logistics Module (MPLM, Mission UF-3), which is also 
known as ISS Resupply and Return (R&R). 
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2.8. Station Modes (as determined by C&C) 
• Standard (nominal housekeeping, internal maintenance, and Payload operations)  
• Microgravity* (needed during Microgravity payload operations) 
• Reboost* (needed during reboost Operations) 
• Proximity Operations (Ops)* (needed during docking and undocking of vehicles 

with ISS)  
• External* (needed during assembly operations and with Robotics system Extra 

Vehicular Activity [EVA]) 
• Survival* (transitions in response to specific failures to ensure ISS survivability)  
• Assured Safe Crew Return (ASCR)* (needed during emergency with unplanned 

vehicle undocking operations) 
• Prop Transfer 
• Gyrodine Spin-up 
• Initial Attitude 

* Software coordination between US Guidance, Navigation, and Control (GN&C) 
and USSR GN&C is required. 

2.9. Standard Out 
Standard Output is the electronic delivery mechanism for all the United States On-
orbit Segment (USOS) generated and interfacing signals and all ISS flight software. 
Standard Out is used for configuring and providing tables for MDMs, PCS 
(reconfiguration tables), and ground systems, such as MCC (TCMS for KSC testing). 
Standard Out C&DH files define: 

• Bus profile for all busses (except some user busses) 
• BC and RT address assignments 
• Command structures and templates 
• Command instances  
• Cyclic data 
• Parameter definition, such as size, data type 
• Conversion information for parameters 
• Broadcast and payload ancillary data 
• Telemetry formats 
KSC uses Standard Out for developing procedures and troubleshooting flight/ground 
Hardware and Software problems. Standard Out:  

• Provides command definition and data visibility 
¾ Broken commands can be identified 
¾ Commands can be developed on an alternate source (MATE, PASS, etc) 

and/or built into scripts for automatic execution. 
• Tells where data is located during troubleshooting or nominal operations 
¾ Raw data can be used to verify flight statuses if there are no other ground 

systems available 
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¾ Multiple locations of data can be verified (raw bus data, and CCS telemetry 
data)  

• Allows ground system development for visibility into critical parameters 
¾ TCMS data base uses CDH file definitions for buildup 
¾ Real time flight vehicle monitoring is made simpler! 

 

2.10. Flight Software  

2.10.1. Documentation 
• Command Description Document (CDD) – Describes the commands for a certain 

CSCI or FWC. 
• Integrated Flight Load (IFL) Build Specification – Listing of all files to be released 

in an IFL. Most files delivered to KSC are released as part of an IFL. There are 
two types of IFLs. 
¾ Ready for Combined Training (RFCT) - The software supporting Space 

Station Training Facility’s (SSTF) RFCT milestone for a Stage; it is not 
required for all flights. 

¾ Flight IFLs 
o Launch IFLs – The software loaded on all MDMs and /or MSDs prior to 

launch. Required for all flights that launch MDMs/MSDs and/or provide 
new PCS. 

o Stage Ops IFL – Software delivered to MCC at approximately launch – 3 
months to enable transition from previous stage configuration to the new 
stage configuration. Required for all stages. 

• Software Requirements Document (SRD) – Definition of operation and 
commands functions included in a revision of software. 

• Telemetry Description Document (TDD) – Describes telemetry available for a 
certain CSCI or Firmware controller. 

• Version Description Document (VDD) – Describes the configuration of a certain 
version of released software for a particular CSCI. A VDD contains: 
¾ Memory Maps (if provided by the software developers) 
¾ Load Instructions  
¾ File listings for specific CSCI 
¾ File build/Bundle instructions 
¾ Revision Levels and Checksum values. 

2.10.2. Test and Verification 
Flight Software (FSW) is tested at the Software Development and Integration Lab 
(SDIL) at the Sonny Carter Facility at Johnson Space Center (JSC). There are four 
different facilities testing different aspects of the software. 

• Mission Build Facility (MBF) – Central software and data library; import/export 
SW products 

• Software Verification Facility (SVF) - SVF is used for FSW Verification, C&DH 
Horizontal Integration, and C&DH Interface Verification. All MDMs (46) on Station 
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(including international MDMs and OIU will be present. It is used for software 
verification only; it is not an avionics simulator.  
Figure 2-6: Three Tiers of MDM Flight Equivalent Unit (FEU) 

• Prime Software Production Facility (PSPF) – C&C and Node 1 MDM SW 
development; CCS and NCS Formal Qualification Test (FQT). 

• ISS System Integration Lab (ISIL) – Flight/ FEU MDMs & RT simulations; 
troubleshooting of SW problems; dry run procedures. 

2.10.3. Maturity Levels 
1. Engineering – Initial/development release; not placed under Configuration 

Management (CM) control by the ISS program. 
2. Integration – Placed under CM Control. 
3. Test Ready Release (TRR) – Preliminary testing complete; ready for formal 

testing; CM controlled release. 
4. FQT – Formal qualification testing complete; CM controlled release. 
5. Flight – FQT and/or Stage testing complete; ready for on-board use. CM 

controlled release. 

2.10.4. Real-time Changes 
• Data Load commands – A command that changes a specific location of memory 

without changing the corresponding checksums. It is usually loaded to DRAM 
memory. 

• Pre-Position Program Load - Changes an area of memory.  Usually at least 256 
words plus the checksum associated with that area of memory. PPL files come in 
two formats: 
¾ Load Image Format (LIF) (final flight loads) – Contains information of what is 

to be changed in memory as well as routing information through a flight 
system. 

¾ Binary – It is loaded through the MATE to memory. It can be loaded to DRAM 
or EEPROM. It consists of a series of Data Load commands. 

2.11. Software Verification Flow  
1. Component Development 

a. Software – FSW (CSCI) and SW Simulators 
b. Hardware – MDM Development and Test. Supported by Generic MDM 

Software and MDM Application Test Environment (MATE) Development and 
Test. Done by Honeywell-AZ at the Bus Test Lab, Huntington Beach 

2. Component Qualification and Acceptance 
a. Hardware and software combine and go to Software Developer/ Factory for 

Integration and FQT. 
b. When successful, software becomes Certified FSW. 

3. Stage Testing and Beyond 
a. Components go to SVF for Stage Testing.  
b. Integrated Test (Acceptance Test/ Multiple Element Integration Test [MEIT]). 

Special approval is required when non-FQT Software is used for testing at KSC. 
c. Launch 
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2.12. Figures 

 
Figure 2-1: Three Tiers of MDM Control  
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Figure 2-2: C&DH Architecture 
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Figure 2-3: MDM Component Architecture 
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SSMDM Boot Firmware
080000 – 09FFFF 

Configuration Table
0A0000 – 0A04F7 

BIT Summary/Results Table 
0A0500 – 0A5FFF 

MDM Boot F/W Vecor 
0A04F8 – 0A04FF 

Sensor Data List Buffer 
0A6200 – 0A81FF 

Utilities Scratch Area
0A8200 – 0A84FF 

 
Application Main Program  

0A8500 - 27FFFF 
(includes Load Image header)

Configuration Table 
0F1000 – 0F1042F 

SSMDM Boot Firmware
0F0000 – 0F0FFF 

User Application S/W (UAS) 
0F10430 – FFFBDF 

(includes UAS Image Header) 

Error Ring Buffer 
FFFBE0 – FFFFEF

 Restart Vector 
FFFFF0 - FFFFFF Reserved

280000 – 4FFFFF

Reserved
B80000 - EFFFFF

Reserved regions and I/O
050000 - 07FFFF 

SRAM 
040000 - 05FFFF 

(includes BIA, IOCC data)
EEPROM Alias

000000 - 03FFFF

DRAM 
080000 - 27FFFF 

(includes CVT, BST, BRT)

SX Backplane
500000 – B7FFFF 

(includes HSRAM, SPD)

 EEPROM
F00000 - FFFFFF

 

Figure 2-4: Standard MDM Memory Map 
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SSMDM Boot Firmware 
080000 – 09FFFF 

BIT Summary/Results 
Table 

MDM Boot F/W Vecor
0A04F8 – 0A04FF 

 0A0000 – 0A04F7 
Configuration Table 

Utilities Scratch Area 
0A8200 – 0A84FF 

Configuration Tabl  e
0F1000 – 0F1042F 

SSMDM Boot Firmware 
0F0000 – 0F0FFF 

User Application S/W (UAS) 
0F10430 – FFFBDF 

(includes UAS Image 
Header) 

  Restart Vector 
FFFFF0 - FFFFFF  Error Ring Buffer 
FFFBE0 – FFFFEF 

Not Used
000000 - 03FFFF 

SRAM
040000 - 05FFFF

ISP, Debug, IOCC, BIA
060000 - 07FFFF

DRAM (8 Meg)
080000 - 87FFFF 

(includes CVT, BST, 

 SX Backplane
880000 – EFFFFF
(includes HSRAM)

 

EEPROM
F00000 - FFFFFF

 
Application Main Program  

0A8500 - 87FFFF 
(includes Load Image 

 

Figure 2-5: Enhanced MDM Memory Map 
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End-Item 
simulators 
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simulators 

UB  
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Local 
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Command 
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LB  

FWC
Sims

Three Tiers of 
MDM FEUs 

Subsystem 
MDMs 

 

Command &
Control  
MDMs 

User 
Buses

Figure 2-6: Three Tiers of MDM Flight Equivalent Unit (FEU) 

2.13. Tables 
I/O Card Typical Use # Ch # of Cards

on ISS 
LLA - 
  Low Level Analog 

Reads analog voltage or supplies the 
current source to measure a voltage drop 
across a Resistive Temperature Device 
(RTD).  Mainly used for precise 
temperatures measurements. 

 
32 

 
57 

HLA - 
  High Level Analog 

Reads analog sensors (pressure, flow rate, 
speed) and supplies power for transducers. 

 
32 

 
24 

AIO - 
  Analog Input Output 

Drives analog effectors (fan speeds, valve 
speeds) and reads analog sensor voltages. 

 
16 

 
22 

DIO - 
  Digital Input Output 

Reads discrete sensors (valve/switch 
positions) and commands discrete effectors 
(valve / switch enable). 

 
 

32 

 
 

54 
 

Table 2-1: I/O Card Uses 
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LLA Fan Speed Indicator (Environmental Control and Life Support System 
[ECLSS]) 
Resistive Thermal Devices (Thermal Control System [TCS]) 

HLA RFCA Inlet low and high flow range (TCS) 
A/L CL EMU1 voltage monitor (EVA) 

AIO RFCA FCV speed command (TCS) 
CCAA TCCV position command (ECLSS) 

DIO Fan Enable command (ECLSS) 
IMV Valve position (ECLSS) 

SDO C&W Panel lights (C&DH) 
LA FWD Port Value solenoid command (ECLSS) 

 
Table 2-2: I/O Card Application 
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3. Military-Standard 1553 Protocol  

3.1. General Information 
Mil-Std-1553 was developed to define a communications bus to interconnect 
different subsystems which needed to share or exchange information. Information is 
transferred between bus terminals via a 1 Mbps digital serial communications 
channel. ISS uses version Mil-Std-1553B. C&DH uses it to transmit health and 
status information and commands and uses dual-redundant channels (channels “A” 
and “B”). The multiplex data bus system has the elementary configuration shown in 
Figure 3-1: Typical Data Bus Architecture. The data bus functions asynchronously in 
a command/response mode, and transmissions occur in a half-duplex manner. Only 
one of the data buses can be active at any given time; if a terminal receives a valid 
command from either bus, it will reset and respond to the new command on the data 
bus it was received.  

3.1.1. Terminals 
• Bus Monitor (BM) - receives bus traffic and extracts selected information to be 

used at a later time.  It is “listen only.” Its information can be used for off-line 
applications and as an information source for Backup Bus Controller. Figure 3-2: 
Bus Monitor Functional Elements 

• Bus Controller (BC) - initiates all information transfers on the data bus. It 
participates in all data transfers, receives status responses, monitors systems 
status. There can only be one active controller on a bus, though it can be an RT 
on another bus. Figure 3-3: Bus Controller Functional Elements 

• Remote Terminal (RT) - any terminal not acting as a BC or BM. Up to 30 RTs 
can be on a 1553 bus. RTs have two sets of 32 message “buffers” of 32 words 
each.  One set is “receive” subaddresses, and the other set are “transmit” 
subaddresses. Messages are addressed to the applicable RT address and 
subaddress. RT address 31 is used for messages to be broadcast to all RTs. The 
RT responds to the last valid command received. Figure 3-4: Remote Terminal 
Functional Elements 

3.1.2. Message Transfer Formats  
The terms “transmit” and “receive” are with respect to the RT. The transfers are 
illustrated in Figure 3-5: Information Transfer Formats. 

• BC to RT transfer (Receive) 
• RT to BC transfer (Transmit) 
• RT to RT transfer (not used for ISS) 
• Mode Command (can be transmit or receive, with or without data) 
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3.1.3. Word Formats 
The data flows in three types of words: command, data, and status, illustrated in 
Figure 3-6: Word Formats. All 1553 words are 20 bits long and encoded in biphase 
(Manchester II) coding. Figure 3-7: Data Encoding. Each word contains a 
synchronization signal (sync) that is 3 bits long, 16 data/command/status bits, and 1 
parity bit. The sync and parity bits are required by the 1553 hardware in determining 
1553 message formats and data errors. Command and status words use a positive 
sync; data words use a negative sync. Figure 3-8: Word Syncs. Odd parity is used 
for 1553. 

• Command – consists of a sync, RT address, transmit/receive bit, 
subaddress/mode, data word count/mode code, and parity bit. 
¾ Sent only by the BC. 
¾ Subaddresses 0 and 31 (00000 and 11111) are used to indicate a mode 

command.Mode code is a means by which the Bus Controller can 
communicate with the multiplex bus related hardware, in order to assist in the 
management of information flow. Table 3-1: Assigned Mode Codes 

• Data – consists of a sync waveform, data bits, and a parity bit. 
• Status – consists of a sync waveform, RT address, message error bit, 

instrumentation bit, service request bit, three reserved bits, broadcast command 
received bit, busy bit, subsystem flag bit, dynamic bus control acceptance bit, 
terminal flag bit, and a parity bit. 
¾ Sent only by an RT. 
¾ Status bits are reset on receipt of a valid command, with the exception of the 

following two mode commands: transmit status and transmit last command. 
¾ The message error bit indicates an error in the previous message with word 

validation, transmission continuity, proper word count, or (optional) illegal 
command detection. The RT sets the bit and ignores the command 
completely, waiting to send status when next contacted by the BC. If the error 
was in the command word, the RT does not set the message error bit and 
ignores the command. Valid commands have good word form. An illegal 
command is a user-defined valid command whose bit combination is not used 
by the user. 

3.2. ISS Transaction 
Figure 3-9: ISS C&DH 1553 Data Bus Architecture 
Table 3-2: 1553 Subaddress Assignment Example 

3.2.1. Types of ISS 1553 Messages 
The following are types of ISS 1553 messages.  There can be other types of 
messages on local or user busses. 

• Broadcast sync - The bus controller’s current processing frame is the first 
transaction of each processing frame. Broadcasts on all busses to let the RTs 
know what processing frame is active. RTs may be command to “sync” to BIA 
(BC). 
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• Broadcast time - Time is broadcast once a second 
• Ancillary (BAD: RT31 Receive subaddresses 13,14; and PSAD: PL-MDM 

Receive subaddresses 22, 23,24):   
¾ Broadcast Ancillary Data (BAD) - Status information from station components 

gathered by the C&C and broadcast back. This is how one MDM finds out the 
status of a component that it does not control. Some other systems also use 
the term “Broadcast Ancillary,” but the data set would be different unless they 
are propagating the BAD. 

¾ Payload Specific Ancillary Data (PSAD) - Goes from the C&C to the Payload 
MDM. The Payload MDM may then pass on all or part of the data to the 
payloads. It is a similar to BAD, but tailored to the Payload needs. 

• Cyclic data - Heath and status data from the RT (transmit subaddresses, number 
of messages varies) 

• Standard commands - Receive subaddresses; For MDMs, usually subaddresses 
27 and 28) 

• Memory load commands - Data packets to the RT (For MDMs and PCS, receive 
subaddresses 15 through 23) 

• Memory dump (normal and extended) - Data packets from the RT. (For MDMs, 
transmit subaddresses 14, 15, 16) 

• Pass through from another bus (cyclic data, commands) 
• Command polls – Command requests from an RT to the BC 
• Binary Data Transfers - S-Band Telemetry and RPCMs 
Figure 3-10: ISS Link Layer Supported Communications Pipes 

3.2.2. Common Status Bits 
The RT responds to the 1553 transfer with a status word, and then data words if any 
were requested. The most significant bits are transferred first with the less significant 
bits following in descending order of value in data word. The following status bits are 
most commonly used for ISS. 

• Most significant 5 bits are the RT address. 
• Message error (message not supported, such as cyclic data when an MDM is in 

diagnostic mode). 
• Service request bit (used by C&T RTs). 
• Busy bit (set when the RT doesn’t have time to respond to the request.  Not used 

by most ISS RTs). 
• Subsystem flag (used by MDMs to indicate diagnostic mode, used by C&T). 

3.2.3. Command 
Commands have a header, which follows the CCSDS definition.  
Figure 3-11: Command Headers. 
Three types of commands are utilized on board the ISS:  Standard Commands, Data 
Load/File Transfer Commands and Non CCSDS Firmware Commands 
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• Standard Commands are used to instruct or command a function at the 
destination of a command and consist of one or two CMSG_CON 1553 
messages of which the first message always contains the CCSDS protocol. 

• Data Load/File Transfer commands are used to transfer data from the source to 
the destination and consists of up to 9 CMSG_CON messages of which the first 
message always contain the CCSDS protocol. 

• Non CCSDS Firmware Commands do not contain CCSDS headers and are used 
to transmit.  

The Command Structure provides a shell for the types of commands that are 
available to be transmitted to a particular destination. Actual transmitted commands 
to the onboard system is identified as 'Instantiated Commands.' The instantiated 
command provides the unique values for the parameters established by the 
Command Structure.  In some cases, commands will be available as ‘Template 
Commands’, which again is based on the Command Structure; however, the actual 
values for the parameters will be inserted at the command source. 
A Command Structure Signal is defined as a structure of digitized Command 
Primitive Signals that could originate from the ground, the PCS, or a MDM/Processor 
CSCI and is transmitted on a 1553 bus via the C&C MDM to the target 
MDM/FC/Processor for the purpose of initiating an action within the target MDM/ 
FC/Processor CSCI.  The purpose for MDM/FC/Processor Command Structure 
signals is to identify the existence of commands to each unique CSCI without 
identifying the specific physical MDM/FC/Processor receiving the command.   

3.2.3.1. Command Routing 
Most flight elements have one or more Application Identifiers (APID), which are 
routing IDs. 

• The APID is a source destination pair. 
• Many MDMs have a pair (or three in the case of the C&C) of MDMs where one 

functions in the “Primary” mode and the other in a “Backup” or “Secondary” 
mode.  For these MDMs, “Logical” APIDs are assigned, so the actual MDM that 
will receive the command depends on what modes the MDMs are in. 

• Most MDMs also have a physical APID which is specifically for that MDM so that 
commands will be routed to that MDM regardless of the mode of the MDM. Not 
all MDMs have physical APIDs for uplink, such as the GNC and the C&C MDMs. 

• An additional bit is associated with the APID (“TYPE” in word 1 in the previous 
table). 0 = CORE, which applies to most of the MDMs, including the payload 
MDM. 1 = Payload, which is for applies to payloads such as the Human 
Research Facility (HRF) 

• In addition to command APIDs, each MDM has an APID for routing data to the 
ground, such as for dump data, so that the ground can tell where the data 
originated. 

• When an MDM receives a command, the APID is checked to see if the command 
destination is that MDM. If not, then the MDM will check the APID table and route 
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the command accordingly.  If the APID is not found in the MDMs APID table, then 
the command will be rejected. 

3.2.3.2. Command Fields 
• For each APID, a sequence count is maintained so that the MDM will know 

whether the command that was received is new or was previously processed.  If 
the sequence count for the particular APID has not changed, then the command 
will be ignored. 

• There is a time ID which indicates what type of time, if any, is included in the 
header.  Time is calculated from midnight, January 5/6, 1980 (This time is related 
to the GPS satellite.) 

• Sequential count which expresses the length of the remainder of the packet 
including checkword if present. The value is the number of bytes (octets) 
following this field minus 1.  (An easy way to calculate the number of words in the 
command is to take the packet length, convert from hex to decimal if necessary, 
add 1, divide by 2 and add 3.) 

• All commands that have CCSDS headers should include a checksum.  The 
checksum is a 16 bit add without carry of all command words (including the 
header) up to but not including the checksum itself. 

• Standard commands on the control busses are transmitted in two 32 word 1553 
messages.  The unused words (based on the packet length field) may be zero 
filled or residual data.   

•  For some lower tier RTs the CCSDS header and fill words are stripped off, such 
as for the C&T equipment and RPCMs. 

3.2.3.3. Command Response 
MDMs provide a command response in cyclic data.  The command response 
consists of: 
¾ Words 1 and 2 of the command (which provides the APID and sequence 

count) 
¾ Command response (0 = good response) 

Figure 3-12: Command Response 
Some MDMs also provide an application layer response, since the standard 
command response is often just a transfer layer response.   An example application 
layer response would be if the MDM is in the wrong state to perform the command. 
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3.3. Figures 

 

Figure 3-1: Typical Data Bus Architecture 
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Figure 3-3: Bus Controller Functional Elements  
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Figure 3-4: Remote Terminal Functional Elements
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Figure 3-5: Information Transfer Formats 
 

 
Figure 3-6: Word Formats 
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Figure 3-7: Data Encoding 

 
 

Figure 3-8: Word Syncs 
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Figure 3-9: ISS C&DH 1553 Data Bus Architecture 
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Figure 3-10: ISS Link Layer Supported Communications Pipes 
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Figure 3-11: Command Headers 
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Figure 3-12: Command Response 
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3.4. Tables 
 

Table 3-1:  Assigned Mode Codes 

Transmit Broadcast
or Mode Function Associated Command Notes

Receive Code Data Word Allowed
T 00000 Dynamic Bus Control No No 1
T 00001 Synchronize No Yes
T 00010 Transmit Status Word No No 2, 3
T 00011 Initiate Self-test No Yes
T 00100 Transmitter Shutdown No Yes 2
T 00101 Override Transmitter Shutdown No Yes 2
T 00110 Inhibit Terminal Flag Bit No Yes 1
T 00111 Override Inhibit Terminal Flad Bit No Yes
T 01000 Reset Remote Terminal No Yes 2
T 01001 Reserved No TBD
⇑ ⇑ ⇑ ⇑ ⇑
⇓ ⇓ ⇓ ⇓ ⇓
T 01111 Reserved No TBD
T 10000 Transmit Vector Word Yes No
R 10001 Synchronize Yes Yes
T 10010 Transmit Last Command Yes No 3
T 10011 Transmit Bit Word Yes No
R 10100 Selected Transmitter Shutdown Yes Yes
R 10101 Override Selected Transmitter Shutdown Yes Yes

T or R 10110 Reserved Yes TBD
⇑ ⇑ ⇑ ⇑ ⇑
⇓ ⇓ ⇓ ⇓ ⇓

T or R 11111 Reserved Yes TBD

Notes:
1 Not Allowed for Broadcast Use by the USAF
2 Required by Mil-Std 1553
3 Remote Terminal does not reset Status Word upon recipient of this Command
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Primary INT Subaddress Assignments
S/A Receive Transmit
00 Mode Code Mode Code
01 LA-2 C&W Panel Control Command INT Cyclic Data (1)
02 N2-1 C&W Panel Control Command INT Cyclic Data (2)
03 N2-2 C&W Panel Control Command INT Cyclic Data (3)
04 Not Used CBM Cyclic Data (1)
05 Not Used LA-1 Cyclic Data (1)
06 Not Used LA-1 Cyclic Data (2)
07 Not Used LA-2 Cyclic Data (1)
08 Not Used LA-2 Cyclic Data (2)
09 Not Used LA-3 Cyclic Data (1)
10 Not Used LA-3 Cyclic Data (2)
11 Not Used AL-1 Cyclic Data (1)
12 Not Used MPLM Cyclic Data (1)
13 Broadcast Ancillary Data (1) MPLM Cyclic Data (2)
14 Broadcast Ancillary Data (2) Data Dump (1)
15 Data Load (1) Data Dump (2)
16 Data Load (2) Data Dump (3)
17 Data Load (3) N2-1 Cyclic Data (1)
18 Data Load (4) Not Used
19 Data Load (5) N2-1 Cyclic Data (1)
20 Data Load (6) N2-1 Cyclic Data (2)
21 Data Load (7) N3 SDS Valve Command Poll
22 Data Load (8) Not Used
23 Data Load (9) Not Used
24 Not Used Not Used
25 Not Used Not Used
26 Not Used CAM -1 Data Acquisition - (reserved)
27 Standard Command (1) CAM -2 Data Acquisition - (reserved)
28 Standard Command (2) BIT Summary Table A
29 Broadcast Time BIT Summary Table B
30 Reserved (Data Wrap Write) Reserved (Data Wrap Read)  

 
Table 3-2: 1553 Subaddress Assignment Example 
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4. Data Telemetry  
4.1. Cyclic Data 
Cyclic Data is health and status data from the RT (transmit subaddresses, number of 
messages varies). 

4.2. Telemetry 
Telemetry is the process of collection, preparation, and transmission of digitized 
information from one point to another via an established communication medium.  
The ISS employs several technologies to accomplish this task, each requiring 
different conventions of description.  
 

4.2.1. Normal S-Band Telemetry Definition 
ISS S-Band Telemetry Definition is the process of packaging data acquired by the 
functioning C&C MDMs from lower-tier devices and making it available for 
transmission to various signal sinks.  Routing varies with the sink and ISS 
configuration.  Basic telemetry constructs vary with the targeted ISS functional 
coverage.  In the ISS nominal telemetry sink and routing scheme, the C&C MDMs 
receive the accumulated signal data via sets of MDM-unique 1553B data acquisition 
messages.  Predefined Telemetry Format tables are utilized by the C&C MDM to 
build S-band telemetry packets.  Packet content and content rate assignments are 
predicated on data acquisition availability and ISS functional status-reporting 
requirements.  There is a predetermined set of telemetry packet types, each 
containing a unique CCSDS header and a set maximum number of words of data.  
The data contained in each packet is allocated to discrete rate groups (10Hz, 1Hz 
and .1 Hz).  Each rate group contains primitive signal data that is stored either in 
words, double words or individually depending on its bit size.  Packets are combined 
by the C&C MDM into a processing frame transfer of telemetry data, which is 
transmitted every 100 milliseconds at high rate or less often at low rate. 
 

4.2.2. Data Organization 
These are the levels of organization for telemetry data. Each unique telemetry 
version is assigned a group PUI as the highest level group identifier, with subgroup 
and signal SPUI content assignments made as necessary to fully define its specific 
version construct and content. For identification and organization, each level below 
version are assigned a group PUI, with subgroup and signal SPUI content 
assignments made as necessary to establish telemetry construct definition within the 
level above it.   
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1. Telemetry Version - that total set of potential telemetry content which is collected 
and organized for transmittal within the largest basic processing increment.  For 
the ISS, that increment is termed a major frame and is composed of 100 units 
called processing frames, each of equal construct.  The C&DH has defined a 
fixed task-scheduling environment based on a 10Hz processing frame from 
which the telemetry task receives its cyclic organization.  Telemetry major frames 
and processing frames may be of a different time base than the C&DH processor 
task scheduling and I/O frames.  Each specific telemetry version is defined to the 
program to enable interim and end-user consumption of the telemetry data.   

2. Processing Frame -that total set of potential telemetry content, which is collected 
and organized for transmittal within one telemetry transmission increment.  ISS 
C&DH design defines 100 such transmissions within each C&DH telemetry major 
frame.   

3. Packet -a CCSDS compliant construct of information with predefined content that 
has been assembled for transmission, one or more of which compose a 
telemetry processing frame transfer of information.     

4. Rate Group - a contiguous set of words within a telemetry packet which have 
been assigned to contain information refreshed at a specified frequency.     

5. CCSDS Header Group - that set of contiguous words within each telemetry 
packet necessary to establish the ISS adopted CCSDS packet protocol for 
telemetry transmissions.   

4.2.3. Word and Double Word Groups 
 

• The Telemetry Word and Double Word Groups that are contained in a full 
telemetry rate group of data are identified by unique group SPUIs.  The telemetry 
content definition inherits these SPUIs, and their attributes, from the data 
acquisition bus messaging definition process necessary to make signals 
available for the telemetry definition process.  

• The Telemetry Signals that are full-length primitives, or contained in telemetry 
word and double word groups of data, are identified by unique signal SPUIs.  The 
telemetry content definition inherits these SPUIs, and their attributes, from the 
established ISS primitive signal definition process.   

4.3. Broadcast Ancillary Data (BAD) 
BAD EXT Data (BED) uses data outputting to command (one MDM outputs and 
changes a bit and this cycles through and is treated as a command by another 
MDM). Status information from station components gathered by the C&C and 
broadcast back. This is how one MDM finds out the status of a component that it 
does not control. Some other systems also use the term “Broadcast Ancillary,” but 
the data set would be different unless they are propagating the BAD. It is broadcast 
to RT address 31. 
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4.4. Payload Ancillary Data  
Payload Ancillary Data (PAD) is system-related data that goes from the C&C to the 
Payload MDM via the 1553B Control Bus. Selected parameters within the PAD are 
then provided to payloads by the Payload MDM. Since the PAD contains system 
data, the PUIs for the parameters to be included in the PAD are already defined. 
The requirements for the parameters contained in PAD come from Payload 
Developers (PD), Payload Integrators (PI), MSFC Payload Operations Personnel, 
etc.  The PAD potentially can change on a per-flight basis because of new 
requirements being received from PDs/PIs, or in response to anomaly resolution. 
It is the responsibility of the Payload Utilization Office to collect the requirements for 
the data that must be contained in the PAD, and to provide the necessary IP&CL 
inputs to the MBF to ensure that the required parameters are contained in the PAD.  
Requirements for the parameters (PUIs) contained in PAD will be provided to the 
MBF during the Engineering Cycle (approx. 90% complete) and during the Flight 
Cycle (100% complete) for each flight with new payloads or subrack payloads.  
PAD is a similar to BAD, but tailored to the Payload needs. 
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5. Test Type Variance in Simulated Data 
For more test configurations in addition to those in this package, go to TCMS 
Simulation Configurations. 

5.1. Utilization 
For Utilization testing, ancillary data is simulated. This is due to the TCMS emulating 
the C&C. The cyclic data from the PL-MDM is real.  

5.1.1. Payload Rack Checkout Unit (PRCU) 
PRCU is the distributed verification of payload interfaces to the ISS ICDs. KSC 
PRCU is used for re-verification of payload interfaces as required, verification of 
ISPR/EXPRESS rack or attached payloads required by Payloads Office to undergo 
verification in PRCU prior to testing in PTCS, and offline post-delivery check.  For 
PRCU, the C&DH system is capable of LRDL, MRDL, and HRDL emulation and 
simulating C&C MDM.  

5.1.2. Payload Test and Checkout System (PTCS ) 
For PTCS, the C&DH system provides high fidelity compliment of on-orbit interfaces 
through the use of Program FEUs (PL MDM, PEHGs) and services to verify 
command and data pathways/interfaces. TCMS simulates C&C and APS RT.  TCMS 
also does S-Band Uplink commanding and system control/monitoring. The following 
equipment is unique to this testing: MATE 3, PDA, and PDG. 
PDSS-KSC provides payload telemetry routing and distribution to EHS-KSC and 
User GSE.  EHS-KSC provides a user interface for uplinking data to ISPR/AP and 
accepting health and status data from the ISPR/AP. PDSS-KSC is a subset of the 
MSFC PDSS system (H/W and S/W) and EHS-KSC is a subset of the MSFC EHS 
system (H/W and S/W) 
Figure 5-1: Utilization Payload Test and Checkout System (PTCS) Design 

5.2. MPLM 
For MPLM testing, TCMS simulates INT-MDM and Orbiter Interface Unit (OIU).   
Figure 5-2: MPLM Post-Rack Installation Test (PRIT) Configuration 
Figure 5-3: MPLM - TCMS Design Certification Review 

5.3. MEIT 3 
Figure 5-4: MEIT3 with Node 2 (JEM-PM/Node 2/US Lab Emulator) 
Figure 5-5: MEIT 3 Caution and Warning Mode 
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5.4. Figures 

 
 

Figure 5-1: Utilization Payload Test and Checkout System (PTCS) Design 
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Figure 5-2: MPLM Post-Rack Installation Test (PRIT) Configuration 
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Figure 5-3: MPLM - TCMS Design Certification Review 
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Figure 5-4: MEIT3 with Node 2 (JEM-PM/Node 2/US Lab Emulator)
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Figure 5-5: MEIT 3 Caution and Warning Mode 
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6. PUI Finder 

6.1. PUI Types 
Program Uniquie Identifiers (PUIs) are used to identify  ISS command and data. The 
following is a list of types of PUIs. A description of some of the PUI types is in Table 
6-1: Types of PUIs.  

• Signal 
• Conversion 
• Word 
• Group (usually rate group, such as 10 Hz, 1Hz, 0.1 Hz) 
• Command Template 
• Command Instance 
• Bus 
• Device (6 characters) 
• Requirement 

6.2. Signal PUIs 
Signal Program Unique Identifiers (SPUIs) are used to identify all ISS signals. An 
ISS signal is defined as data needed/provided by the flight crew, ground crew, ISS 
hardware elements, ISS firmware controllers, ISS PCS, or ISS MDM CSCI. ISS 
Signals are those signals that traverse (in either direction) the wiring between sensor 
devices, effectors, and the on-board processors, which are used by ground or 
onboard operations for command and control of the Station. 
Figure 6-1: ISS Signal Data Domain 
Figure 6-2: ISS Signal Data Domain Detail 
The name given to a signal PUI is based on its following qualities:  

• Functional System Data Provider: RT device, generic group device, or logical 
MDM device generating (source) or receiving (destination) the Message Content 
Group Signal (6 characters) 
1. Element  (2) 
2. Functional system (1) 
3. Subsystem/assembly/CSCI (3) 

• Generic Device Code (2 characters) 
• Sequence Number (4 characters) 
• Signal Type (1 character) 
Figure 6-3: Signal PUI Format 
There are five categories of SPUIs: 

• Hardware Primitive 
• Firmware Primitive  
• Software Primitive 
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• Groups 
• Command Instantiations 

6.3. Group Signals 
The concept of signal grouping is utilized throughout the signal data definition and 
capture discipline and is the identifying of instances of physical hierarchical 
containment structures for signals.  These structures are given the name “groups”.  
They may consist of a grouping of signal information as it appears on a 1553B or 
non-1553 data bus, or a grouping of signal information as it appears within an air-to-
ground telemetry transmission, or a grouping of signal information as it appears 
within a CCSDS header, etc.  Group identifiers (SPUIs) are assigned as an abstract 
method of identifying these structures that are inherent in the designed C&DH signal 
management system. 

6.4. Downloading PUI Finder 
Before using PUI Finder, it is necessary to have PUI Finder and special MS Access 
databases downloaded or linked. The program and databases can be found through 
links on the Command & Telemetry Certification & Operations website at 
http://hsi.jsc.nasa.gov/c&t/index.htm. 

6.5. Using PUI Finder 

6.5.1. Opening PUI 
1. Select the Database from which to view the PUIs.  

Figure 6-4: Selecting Database 
2. Select the PUI text box and enter the name of the PUI. Select Find. 

Figure 6-5: Entering PUI  

6.5.2. General Retrieval Data 
1. Select the F01 FW/SW tab. Relevant data: Data Type. For data type, the 

numbers represent the number of relevant bits; the letters represent what form of 
data the numbers are in. Full explanations of all the data types can be found in 
Appendix J of the Prime Contractors Software Standards and Procedures 
Specifications. The common forms and how to find their meaning are as follows: 
Figure 6-6: F01 FW/SW (Firmware/Software) 
a. E is enumerated; each value represents a state conversion. Select the F21SC 

tab. The Code column lists the possible data values and the corresponding 
definition is under the Definition column. 
Figure 6-7: F21 SC (State Conversion) 

b. UI is unsigned integer; it needs to be converted from hexadecimal to decimal. 
c. SI is signed magnitude; the sign of the unit needs to be figured out and the 

value of the other 15 bits needs to be converted from hexadecimal to decimal. 
Select the F22PC tab. The first bit of the data determined the sign of the data; 
0 value for positive, 1 value for negative. Therefore, for a value of 800A, your 
16 bit signed integer value is Negative 10; for a value of 000A, your 16 bit 
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signed integer value is Positive 10. The Conversion Units column lists the unit 
the data is to represent. When there is a curve, it is necessary to convert the 
data to reach its proper value. To convert to the required unit, assign the 
given data to be the unit x and use the formula A0 + A1x + A2x2 + A3x3 + A4x4 
+ A5x5. There may be different coefficients based on certain restrictions on 
the data, such as if it is + or -, or if it is with in a certain range. 
Figure 6-8: F22 PC (Polynomial Calibration) 

d. F is floating point; it is a real number represented by a three-field binary 
format as required by IEEE standard 754 for floating point numerics. It needs 
to be converted from hexadecimal to IEEE. There is a converter on TCMS at 
location/HexToIeee ######## and on the web at 
http://babbage.cs.qc.edu/courses/cs341/IEEE-754hex32.html. There also is a 
converter for IEEE to hexadecimal on TCMS at location/IeeeToHex 
################################ and on the web at 
http://babbage.cs.qc.edu/courses/cs341/IEEE-754.html. 

6.5.3. Message Retrieval Data 
1. Select the Msg Ref tab. Relevant data (in the same row(s) as the bus from which 

data is required): Source PUI, Processing Frame(s), Subaddress(es), Word 
Offset, Bit Offset, and Word Order. 
Figure 6-9: Message Reference 

2. RT Address: 
a. Select the PUI text box and enter the name of the Source PUI.  
b. Select Device in the PUI Type box. Select Find. 
c. Select the CDH ADD tab. Go to the row with the relevant bus name. Relevant 

data: Bus address (RT address). This is not always dependable and the CDH 
Architecture Design Document (ADD) is where to find the exact information. 

Figure 6-10: Command & Data Handling Architecture Design Document 
3. Select the Pipe Ref tab. Relevant data: Rate. This information concerns how 

many times a second the data is updated (1 Hz: updates once a second; 10 Hz: 
updates ten times a second) 
Figure 6-11: Pipe Reference 

6.5.4. Telemetry Retrieval Data 
1. Select the Tlm Ref tab. Relevant data (in the same row as the telemetry version 

used during the required time period): Telemetry Group PUI, Telemetry Group 
Name, Tlm Frame, Tlm Group, Word Offset, Bit Offset, and Word Order. 
Figure 6-12: Telemetry Reference 

2. Open the Telemetry Group PUI found under the Signal PUI’s Tlm Ref tab. 
a. Select the PUI text box and enter the name of the Telemetry Group PUI. 

Select Find. 
b. Select the F03 GD tab. Relevant Data: Content Offset. 
Figure 6-13: F03 GD (Group Records) 
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Notes:  
1. In the event that the relevant subaddress(es) does not display the processing 

frames, there is always at least one subaddress with a frame counter to 
reference for that subaddress(es). This can be found in the   

2. PUI finder expresses all numbers in decimal. The raw data is expressed in 
hexadecimal, including the processing frames. If need help to convert from 
decimal to hexadecimal and vice versa, use the Calculator program found under 
Accessories under Programs on the Start menu in Windows. Select Views, and 
then select Scientific. Use the radio buttons to go from one format to the other. 

6.5.5. Using Find 
1. Select the relevant tab. 
2. Select Edit > Find. 

Figure 6-14: Edit > Find 
3. Enter the information needed (i.e. PUI, number, word) and change options as 

necessary. 
Figure 6-15: Find Box 

4. Select Find. If necessary, select Find Next to go to the next occurrence of 
information needed. 

5. Select Cancel to exit Find. 

6.6. Unroll 
Unroll is a tool used to navigate from lower groups to higher groups. The Unroll tab 
recursively decomposes groups into their lowest contents. The information extracted 
is from entered PUI’s definition in the F03 table of the database. 

6.6.1. Unroll Modes 
Unroll has in two basic modes: Normal Unroll and Telemetry Unroll.  The mode is 
automatically determined based upon the Group Type of the PUI being unrolled.   

6.6.1.1. Normal Unroll 
The following information is shown: Word PUI; Signal PUI; Data Type; Name; Word 
Offset; Bit Offset. Group PUIs go under Word PUI and Signal PUIs go under Signal 
PUI. Both Group PUIs and Signal PUIs have their data types and word offsets 
displayed; only Signal PUIs display bit offsets. 

6.6.1.2. Telemetry Unroll 
The following information is shown: Word PUI; Signal PUI; Data Type; Name; 
TLM_PROF (telemetry processing frame number); TLM_GRP (telemetry group 
number); Word Offset; Bit Offset. The telemetry processing frame column is only 
displayed when unrolling telemetry versions.  For larger telemetry streams, Custom 
Unroll may be necessary, as the computer will most likely run out of memory before 
all records are displayed. 
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6.6.2. Default Unroll 
1. Select the Unroll tab. 
2. Select the PUI text box and enter the name of the PUI (must be a group PUI). 
3. Select Unroll. 

Figure 6-16: Default Unroll 

6.6.3. Customized Unroll 
1. Select the Unroll tab. 
2. Select the PUI text box and enter the name of the PUI (must be a group PUI). 
3. Select Customize. 

Figure 6-17: Customize Unroll 
Figure 6-18: Customize Unroll Settings 
Note: In any box, select Cancel to leave the box without any changes made 
taking effect. In the Customized Unroll Settings box, select the Restore Default 
Settings to undo all customized settings and close the Customized Unroll box. 

4. Select the Set Group Columns box and make any necessary changes. Select 
OK. 
Figure 6-19: Set Group Columns 

5. Select the Set Signal Columns box and make any necessary changes. Select 
OK. 
Figure 6-20: Set Signal Columns 

6. Select the radio button next to the desired Output Setting. To view in the PUI 
Finder Screen, select Screen. To save to a file, select File (Tab Indent) or File 
(No Tab Indent). For many group PUIs, it will be necessary to save the unroll to 
a file. The unroll will be too big to be outputted to the screen.  

7. To save the current configuration to a file for later use, select Save A 
Configuration To A File. Select the folder the file is to be saved to, type the 
name of the configuration file in the text box and select Save. 
Figure 6-21: Save a Configuration to a File 

8. To load a preset configuration from a file for later use, select Load A 
Configuration From A File. Select the folder the file is saved in, select the name 
of the configuration file in the text box and select Open. 
Figure 6-22: Load a Configuration from a File 

9. Select Use Custom Settings. 
10. Select Unroll 
11. If the Output Setting is to a file, select the folder the file is to be saved to, type the 

name of the configuration file in the text box and select Save. 
Figure 6-23: Save an Unroll to File 
Note: To view a saved unroll, open the file using Internet Explorer or Notepad. 
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6.7. Figures 
 
 

 
 

Figure 6-1: ISS Signal Data Domain 
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Figure 6-2: ISS Signal Data Domain Detail 

 

Figure 6-3: Signal PUI Format 
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Figure 6-4: Selecting Database 

 

Figure 6-5: Entering PUI 

 

Figure 6-6: F01 Firmware/Software 
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Figure 6-7: F21 SC 

 

Figure 6-8: Message Reference 

 

 

Figure 6-9: F22 PC 

 

Figure 6-10: Command & Data Handling Architecture Design Document 
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Figure 6-11: Pipe Reference 

 
 

Figure 6-12: Telemetry Reference 

 
 

Figure 6-13: F03 GD (Group Records) 

 
 

Figure 6-14: Edit > Find 

 
Figure 6-15: Find Box 
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Figure 6-16: Default Unroll 

 
 

Figure 6-17: Customize Unroll 

 
 

Figure 6-18: Customize Unroll Settings 
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Figure 6-19: Set Group Columns 
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Figure 6-20: Set Signal Columns 

 

 
 

Figure 6-21: Save a Configuration to a File 
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Figure 6-22: Load a Configuration from a File 
 

 
 

Figure 6-23: Save an Unroll to File 
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6.8. Tables 
 
Type of PUI Paragraph/General Description Usage 

Requirement PUI 
(RPUI) 

Seven(7) character fixed format 
identifiers assigned to uniquely identify 
each software requirement in the Part 1 
Interface Control Documents (ICDs). 

1) Part 1 SW ICD 
2) Part 2 SW ICD 
 

Signal PUI 
(SPUI) 

 

Thirteen(13) character fixed format 
identifiers assigned to uniquely identify 
each and all ISS signals generated, or 
utilized by, the design elements defined 
in the Part 2 ICDs and IP&CL. The 
SPUI also will be used to identify RPCM 
channels in the Resource Management 
area of the VMDB. 

1) Part 2 SW ICD 
2) IP&CL 
3) Resource Mgmt 
 

Device PUI 
(DPUI) 

 

Six(6) character fixed format identifiers 
assigned to uniquely identify Hardware 
Devices, Firmware Controllers, MDMs, 
and Special Software Devices (Logical 
and Groups) which will be the IP&CL 
source for all ISS signals. The DPUI 
also will be used to identify sources and 
loads in the Resource Management 
area of the VMDB. 

1) IP&CL 
2) Resource Mgmt 
 

Bus PUI 
(BPUI) 

 

Thirteen(13) character fixed format 
identifiers assigned to uniquely identify 
all the Data Buses utilized by the ISS 
MDMs and Firmware Controllers. 

IP&CL 
 

Conversion PUI 
(CPUI) 

 

Thirteen(13) character fixed format 
identifiers assigned to uniquely identify 
all the State Conversion and Calibration 
Curve tables required to interpret ISS 
discrete signals (i.e. state conversion) 
and analog signals (i.e. calibration 
curves). 

IP&CL 
 

 
Table 6-1: Types of PUIs 
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7. TCMS  

7.1. General Retrieval Parameters 
 

1. In TCMS Main Screen, select Retrieve Session with the mouse. 
Figure 7-1: TCMS Main Screen > Retrieve Session 

2. Select New (if past retrieval is required, select that particular retrieval). Select 
OK. 
Figure 7-2: Retrieval List 

3. The Retrieve Label Prompt appears. Select the default name, and type in 
required name of the retrieval session (the cursor does not have to be in the text 
box for this entry). Select OK. 
Figure 7-3: Retrieval Label Prompt 

4. In the Retrieve Session, select Test ID.  
Figure 7-4: Retrieval Session > Test ID 
Scroll the available choices and select the one you require. If the test you wish to 
view data from is currently occurring, the Test ID will be the same as in Test in 
the main menu. Select OK.  
Figure 7-5: Test ID Selection 

Note: DB Name is automatically given the same value. 
5. Select Retrieval Times > All Times.  

Figure 7-6: Retrieval Times > All Times 
The disk type (magnetic or optical), disk label, and time period for each disk 
appear for the entire length of time of the test; the disks are sorted by disk type 
(magnetic first) and then earliest start time. This is useful if the time of an event, 
but not the Test ID, is known; it helps determine if a Test ID(s) contains the 
required time period. 
Figure 7-7: Retrieval Times 

6. Move the cursor into the UTC start time. The format for the time is the last two 
digits of the year followed by GMT. To modify the time, place the cursor in front 
of the first digit that you wish to modify and select. Begin typing in time. Though 
cannot see where cursor currently located, it writes over the next digit and 
backspace can be used. When the required time is displayed, place the cursor in 
the text box and press Enter. A message in the Retrieval Message Area will 
confirm that the new UTC start time has been accepted.  
Figure 7-8: Retrieval Message Area 
Figure 7-9: UTC Start Time Acceptance 
In there is an invalid action (such as entering a time incorrectly) or the attention 
of the user is required, a yellow message will appear in the Retrieval Message 
Area. The retrieval will not execute until invalid actions have been rectified. 
Figure 7-10: UTC Start Time Rejection 

Note: Duration will automatically calculate and display the amount of 
time between the entered UTC start time and UTC stop time. If without 
a value, UTC stop time will automatically update to the time at which the 
UTC start time was entered. If Duration is changed, the UTC stop time 
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will automatically update and vice versa. If all three have a value and 
either UTC start or stop time are changed, Duration will change to 
accommodate their difference.  

7. Move the cursor into Duration. The format for the amount of time is in GMT. To 
modify the time, place the cursor in front of the first digit that you wish to modify 
and select. Begin typing in time. Though cannot see where cursor currently 
located, it writes over the next digit and backspace can be used. When the 
required time is displayed, place the cursor in the text box and press Enter. A 
message in the Retrieval Message Area will confirm that the new Duration has 
been accepted. 
Figure 7-11: Duration Acceptance 

OR 
Move the cursor into the UTC stop time. The format for the time is the last two 
digits of the year followed by GMT. To modify the time, place the cursor in front 
of the first digit that you wish to modify and select. Begin typing in time. Though 
cannot see where cursor currently located, it writes over the next digit and 
backspace can be used. When the required time is displayed, place the cursor in 
the text box and press Enter. A message in the Retrieval Message Area will 
confirm that the new UTC stop time has been accepted. 
Figure 7-12: UTC Stop Time Acceptance 

Note (for processed retrievals only): Unless a PUI is enabled or 
experiences a change in status, the status is displayed every twenty 
minutes. If a time period of less than twenty minutes falls between the 
times when the status is updated and there is no enabling or change in 
status during that time period, no data is displayed. 
Figure 7-13: Processed Retrieval Time 

8. Select Retrieval Times > Defined Times.  
Figure 7-14: Retrieval Times > Defined Times 
The disk type (magnetic or optical), disk label, and time period for each disk 
appear only for the time between the UTC start and stop times; the disks are 
sorted by disk type (magnetic first) and then earliest start time.   
Figure 7-15: Defined Times 
If all of the listed disks are on magnetic (immediate, temporary storage), retrieval 
can be executed without problems. If some or all of the listed disks are optical 
(permanent storage), call the TCMS Control Room (7-6629) and inform them of 
which disks need to be inserted in which drives. In the event that there are more 
disks than available drives, have the disks from the beginning of the time period 
put in first. A yellow message appears in the Retrieval Message Area when 
switching from one disk to another during retrieval.  
Figure 7-16: Switching Disks 
At this point, call the TCMS Control Room inform them to remove the disk that is 
no longer being used and put in the next disk that is not already in a drive. 

9. Select Ret Dest Figure 7-17: Retrieval Destination  
and enter the filename you want the retrieved data saved to in the text box. 
Select OK. 
Figure 7-18: File Manager 
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7.2. Raw-1553 Retrieval 

7.2.1. Raw-1553 Message Retrieval 

7.2.1.1. Raw Retrieval Definition Parameters 
1. Select Retrieval Definition > Raw-1553. 

Figure 7-19: Retrieval Definition > Raw-1553 
2. Select Raw-1553 Msg Ret. 

Figure 7-20: Raw-1553 Message Retrieval 
3. Select the required bus and select OK. 

Figure 7-21: Bus PUI Selection 
4. Select Command Words.  

Figure 7-22: Raw-1553 Filter Parameter Definition 
5. Select RT > required RT Address (while holding down left mouse button). 

Figure 7-23: RT Selection in Command Words 
Select T/R > required R or T or * if both are required (while holding down left 
mouse button).  
Figure 7-24: T/R Selection in Command Words 
Select the text box under Subaddress and enter the required Subaddress(es) 
(there can be multiple ones, entered individually or as a series)(ex: 2, 5-9, 20, 
31). Repeat for all required RT Addresses.  
Figure 7-25: Subaddress Selection in Command Words 
Select Done. 

6. Select Done. 
Note: To modify parameters after selecting done, simply select Raw-
1553 Msg Ret. The Retrieval Definition Confirmation window will appear, 
giving the options to Modify, Remove, or Cancel the retrieval 
parameters. Select the option that applies. 
Figure 7-26: Retrieval Definition Confirmation 

 

7.2.1.2. Executing Retrieval 
1. Select Retrieval Control > Execute. 

Figure 7-27: Retrieval Control > Execute  
2. When one or more retrievals are already occurring, a window will appear with two 

options. On Queue delays the retrieval until the retrievals ahead of it are done; 
Concurrent executes the retrieval concurrent with the other retrievals. Unless 
there is a reason to wait for the other retrievals to finish (e.g. eight retrievals 
already occurring), select Concurrent and select OK. 
Figure 7-28: Concurrent/On Queue 
Figure 7-29: Retrieval Executing 

Note: If ever need to abort retrieval after executing, select Retrieval 
Control > Abort.  
Figure 7-30: Retrieval Control >Abort 
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A window will appear, giving the options to Abort With Save or Abort 
Without Save. The Abort With Save saves data from the retrieval up to 
the point that abort was selected. Select the option that applies.  
Figure 7-31: Abort Retrieval 
If ever need to pause a retrieval, select Retrieval Control > Pause.  
Figure 7-32: Retrieval Control > Pause 
To resume the retrieval, select Retrieval Control > Resume.  
Figure 7-33: Retrieval Control > Resume 
If the disk with the necessary data is not inserted into the proper drive, 
the Load Disk/Tape Dialog window will appear informing you of which 
disk needs to be inserted into which drive.  
Figure 7-34: Load Disk/Tape Dialog 
Call TCMS Control Room (7-6629) and ask them to do this for you, then 
select OK. If the disk is still not in the proper drive, the window will 
reappear.  

3. Wait until Retrieval Complete appears in the Retrieval Message Area. 
Figure 7-35: Retrieval Complete 

 

7.2.1.3. Viewing Raw Data 
Note: Some of these steps concern viewing the data during testing. If 
you are able to view the file in Notepad or a similar program, ignore 
steps 1-3 and 10. 

1. To view the file containing the raw data, select Rlog in DBS from the TCMS 
main screen.  
Figure 7-36: Rlog in DBS 

2. Making sure the cursor is in the window, enter pwd to confirm that you are in the 
same directory as the data file.  

3. Enter pg filename.txt is to view the data file.  
Figure 7-37: Viewing Data File 

Note: A shortcut is to enter ls –latr to view most recently updated files in 
directory. Select the data file to view, the type pg , making sure to 
include the space after pg. The select with the middle button of the 
mouse and press Enter. Also, to reuse previous commands, press the 
Esc key. Then press the K and J keys to scroll backward and forward, 
respectively, through previous commands. When required command 
found, press Enter to execute. 

4. The raw data is displayed in sets of data. Each set of data is for an individual 
subaddress for each processing frame. The sets of data are separated by a row 
with the following information: GMT, Bus, Channel, RT address, subaddress and 
R/T. Each set of data contains 32 words in two rows, four characters per word.  
Figure 7-38: Raw-1553 Message Data File 

5. Find the processing frame(s) (which are in hexadecimal) relevant to PUI. For 
cyclic data, it will be in the first word of first subaddress of the cyclic data packet. 
For broadcast ancillary data, it will primarily be in the eighth word of subaddress 
13. The processing frame is seven least significant bits of its word and is an 
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unsigned integer. There are several ways to scroll through the document. The 
enter key scrolls forward 16 lines. +### moves forward ### lines, -### moves 
back ### lines. By moving the mouse and holding down with the middle button, it 
is possible to scroll up or down through data already revealed by moving the 
mouse in that respective direction. Entering a forward slash followed by 
characters (ex. /0A03) skips forward to the next occurrence of that sequence of 
characters. If the first occurrence of the sequence is not the required one, 
entering only a forward slash (/) will repeat the search for the same sequence. 
Figure 7-39: Moving in Data File 

6. If the processing frame counter is not in the subaddress relevant to the PUI, go to 
the relevant subaddress in the same processing frame (if the relevant 
subaddress is greater than the processing frame counter, then the next relevant 
subaddress; if the relevant subaddress less than the processing frame counter, 
then the previous relevant subaddress). 

7. Find the word corresponding to the word offset. The first row contains words 1-
16; the second row contains words 17-32. The word offset ranges from 1-32 (e.g. 
a word offset of 10 would by the tenth word from the left in the first row; a word 
offset of 20 would by the fourth word from the left in the second row). If the word 
order is Intel (only applicable with data types of two or four words), the extracted 
words need to be word swapped. This is because Intel transmits the least 
significant word first instead of the most significant word first as required by Mil-
Std-1553. Examples: if the extracted words are 43ab 78c9, then the data is 78c9 
43ab; if the extracted words are 43ab 78c9 56f4 d12e, then the data is d12e 56f4 
43ab 78c9. 

8. Once in the required word, find the first bit of the data for the required PUI. Each 
word contains 16 bits, 4 bits per character. The bits in a word are labeled 0-15.  
|0 1 2 3|4 5 6 7|8 9 10 11|12 13 14 15| The bit offset is the first bit in the data. 
The required bit is that labeled bit (ex. if the bit offset is 7, then the first bit is bit 7, 
which is the eighth bit from the left). 

9. Once beginning with required bit, the amount of data corresponding the PUI is 
the data type (ex. if the bit offset is 7 and the data type is 3 bits, then the data 
relevant to the PUI is bits 7-9, the eighth, ninth, and tenth bits from the left).  

10. Enter q to exit viewing file (or press Enter at the end of file). 
Figure 7-40: Exiting Data File 

7.2.2. Raw-1553 Telemetry Retrieval 

7.2.2.1. Raw Retrieval Definition Parameters 
1. Select Retrieval Definition > Raw-1553. 

Figure 7-19: Retrieval Definition > Raw-1553 
2. Select Raw-1553 Tlm Ret. 

Figure 7-41: Raw-1553 Telemetry Retrieval 
3. Select the required bus (the S-BAND one) and select OK. 

Figure 7-42: S-Band Bus PUI Selection 
4. Select the text box under FMT ID.  

Figure 7-43: Raw-1553 Telemetry Formats 
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5. Select the required Format (Telemetry Group from PUI Finder) and select OK. 
An asterisk or a zero indicates a wild card selection. Up to eight formats may be 
selected, each in a different row and each having all columns filled in. 

6. Figure 7-44: Format ID SelectionSelect the text box under PROC FRAME and 
enter the required Processing Frame(s) (Telemetry Frame from PUI Finder). 
There can be multiple ones, entered individually or as a series (ex: 2, 5-9, 20, 31) 
and range from 0 to 99 inclusive, depending on the format.  
Figure 7-45: Processing Frame Selection 

7. Select the text box under RATE. Select the required Rate (the Rate, which 
appears right before the word Rate, is found within the Telemetry Group Name 
from PUI Finder) and select OK. 
Figure 7-46: Rate Selection 

8. Select the text box under START WD and enter the required Start Word. To 
determine Start Word: use Table 7-1: Start Word Determination or Content Offset 
+ Word Offset – 1 = Start Word (e.g. for Content Offset = 57 and Word Offset = 
9, Start Word = 65) 
Figure 7-47: Start Word Selection 

9. Select the text box under NMBR WDS and enter the required Number of 
Words. Number of words will be as follows: 1 for 16 bits and less, 2 for 16-32 
bits, and 4 for 64 bits. An asterisk indicates a wild card selection. 
Figure 7-48: Number of Words Selection 
Select Done. 

10. Select Done. 
Note: To modify parameters after selecting done, simply select Raw-
1553 Tlm Ret. The Retrieval Definition Confirmation window will appear, 
giving the options to Modify, Remove, or Cancel the retrieval 
parameters. Select the option that applies. 
Figure 7-26: Retrieval Definition Confirmation 

 

7.2.2.2. Executing Retrieval 
1. Select Retrieval Control > Execute. 

Figure 7-27: Retrieval Control > Execute  
2. When one or more retrievals are already occurring, a window will appear with two 

options. On Queue delays the retrieval until the retrievals ahead of it are done; 
Concurrent executes the retrieval concurrent with the other retrievals. Unless 
there is a reason to wait for the other retrievals to finish (e.g. eight retrievals 
already occurring), select Concurrent and select OK. 
Figure 7-28: Concurrent/On Queue 
Figure 7-29: Retrieval Executing 

Note: If ever need to abort retrieval after executing, select Retrieval 
Control > Abort.  
Figure 7-30: Retrieval Control >Abort 
A window will appear, giving the options to Abort With Save or Abort 
Without Save. The Abort With Save saves data from the retrieval up to 
the point that abort was selected. Select the option that applies.  
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Figure 7-31: Abort Retrieval 
If ever need to pause a retrieval, select Retrieval Control > Pause.  
Figure 7-32: Retrieval Control > Pause 
To resume the retrieval, select Retrieval Control > Resume.  
Figure 7-33: Retrieval Control > Resume 
If the disk with the necessary data is not inserted into the proper drive, 
the Load Disk/Tape Dialog window will appear informing you of which 
disk needs to be inserted into which drive.  
Figure 7-34: Load Disk/Tape Dialog 
Call TCMS Control Room (7-6629) and ask them to do this for you, then 
select OK. If the disk is still not in the proper drive, the window will 
reappear.  

3. Wait until Retrieval Complete appears in the Retrieval Message Area. 
Figure 7-35: Retrieval Complete 

 

7.2.2.3. Viewing Raw Data 
Note: Some of these steps concern viewing the data during testing. If 
you are able to view the file in Notepad or a similar program, ignore 
steps 1-3 and 10. 

1. To view the file containing the raw data, select Rlog in DBS from the TCMS 
main screen.  
Figure 7-36: Rlog in DBS 

2. Making sure the cursor is in the window, enter pwd to confirm that you are in the 
same directory as the data file.  

3. Enter pg filename.txt is to view the data file.  
Figure 7-37: Viewing Data File 

Note: A shortcut is to enter ls –latr to view most recently updated files in 
directory. Select the data file to view, the type pg , making sure to 
include the space after pg. The select with the middle button of the 
mouse and press Enter. Also, to reuse previous commands, press the 
Esc key. Then press the K and J keys to scroll backward and forward, 
respectively, through previous commands. When required command 
found, press Enter to execute. 

4. The raw data is displayed in sets of data. Each set of data is for an individual 
subaddress for each processing frame. The sets of data are separated by a row 
with the following information: GMT, Bus, Channel, Format Number and ID, 
Version, and Processing Frame. Each set of data contains the first row of 16 data 
words, followed by the row in which the start word appears and any other rows 
containing requested data.  
Figure 7-49: Raw-1553 Telemetry Data File 

5. Find the relevant GMT. There are several ways to scroll through the document. 
The enter key scrolls forward 16 lines. +### moves forward ### lines, -### 
moves back ### lines. By moving the mouse and holding down with the middle 
button, it is possible to scroll up or down through data already revealed by 
moving the mouse in that respective direction. Entering a forward slash followed 
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by characters (ex. /0A03) skips forward to the next occurrence of that sequence 
of characters. If the first occurrence of the sequence is not the required one, 
entering only a forward slash (/) will repeat the search for the same sequence. 
Figure 7-39: Moving in Data File 

6. Find the start word. Each row has a number to the left of it indicating the word 
number of the first word in the row. The row 1 contains words 1-16; the row 49 
contains words 49-64. The start word row has the words preceding the start word 
in that row and the corresponding number of words following the start word that 
was requested. If the number of words is not specified, then all words following 
the start word for that data set are displayed (maximum word 99). The start word 
ranges in location depending on its position from the first word of the row (e.g. a 
start word of 30 would by the fourteenth word from the left in row 17; a start word 
of 67 would by the third word from the left in row 65). 

7. Once at the start word, the data required is the start word plus the words 
following totaling the number of words (e.g. if the start word is word 45 and 
number of words is two, than the data required is words 45 and 46). If the word 
order is Intel (only applicable with data types of two or four words), the extracted 
words need to be word swapped. This is because Intel transmits the least 
significant word first instead of the most significant word first as required by Mil-
Std-1553. Examples: if the extracted words are 43ab 78c9, then the data is 78c9 
43ab; if the extracted words are 43ab 78c9 56f4 d12e, then the data is d12e 56f4 
43ab 78c9. 

8. Once in the required word, find the first bit of the data for the required PUI. Each 
word contains 16 bits, 4 bits per character. The bits in a word are labeled 0-15.  
|0 1 2 3|4 5 6 7|8 9 10 11|12 13 14 15| The bit offset is the first bit in the data. 
The required bit is that labeled bit (ex. if the bit offset is 7, then the first bit is bit 7, 
which is the eighth bit from the left). 

9. Once beginning with required bit, the amount of data corresponding the PUI is 
the data type (ex. if the bit offset is 7 and the data type is 3 bits, then the data 
relevant to the PUI is bits 7-9, the eighth, ninth, and tenth bits from the left).  

10. Enter q to exit viewing file (or press Enter at the end of file). 
Figure 7-40: Exiting Data File 

7.3. Processed Retrieval 
Only PUIs that have been previously designated so are processed and can be 
retrieved as such. This is mainly an issue for MEIT testing, which, due to the very 
large number of PUIs for this type of testing, needs to be limited in selecting which 
PUIs are processed.  
A limitation of processed PUIs is that for enumerated data types, only 16 states 
(values) can be processed. However, the raw data will still be received and the 
description can be used to express the state. 

7.3.1. Processed Retrieval Definition Parameters 
1. Select Retrieval Definition > Proc. 

Figure 7-50: Retrieval Definition > Proc 
2. Select Processed Meas. 
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Figure 7-51: Processed Meas 
3. Move the cursor into the Wildcard box and select. Enter the information about 

the required PUI(s), using the asterisk to represent zero, one, or multiple 
characters. Multiple asterisks can be used anywhere in the PUI. With the cursor 
still in the text box, press Enter. 
Figure 7-52: Displaying PUI’s with Wildcard 

Note: If PUI information entered does not find any PUIs, then nothing will 
be displayed and a red error message will appear in the Retrieval 
Message Area. 
Figure 7-53: MSID Error 

4. Scroll PUIs meeting parameters and select desired PUI(s). Multiple PUIs can be 
selected/deselected by utilizing the Control and Shift keys. Select Add. 
Figure 7-54: Selecting PUIs with Wildcard 

OR 
Move the cursor into the Manual box and select. Enter the exact name of the 
required PUI, place the cursor in the text box, and press Enter. 
Figure 7-5546: Selecting PUIs by Manual Entry 

5. To remove PUI(s) mistakenly added to list, select unnecessary PUI(s) and select 
Delete. 
Figure 7-56: Deselecting PUIs 

6. Select Done. 
 

7.3.2. Executing Retrieval 
1. Select Retrieval Control > Execute. 

Figure 7-27: Retrieval Control > Execute  
2. When one or more retrievals are already occurring, a window will appear with two 

options. On Queue delays the retrieval until the retrievals ahead of it are done; 
Concurrent executes the retrieval concurrent with the other retrievals. Unless 
there is a reason to wait for the other retrievals to finish (e.g. eight retrievals 
already occurring), select Concurrent and select OK. 
Figure 7-28: Concurrent/On Queue 
Figure 7-29: Retrieval Executing 

Note: If ever need to abort retrieval after executing, select Retrieval 
Control > Abort.  
Figure 7-30: Retrieval Control >Abort 
A window will appear, giving the options to Abort With Save or Abort 
Without Save. The Abort With Save saves data from the retrieval up to 
the point that abort was selected. Select the option that applies.  
Figure 7-31: Abort Retrieval 
If ever need to pause a retrieval, select Retrieval Control > Pause.  
Figure 7-32: Retrieval Control > Pause 
To resume the retrieval, select Retrieval Control > Resume.  
Figure 7-33: Retrieval Control > Resume 
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If the disk with the necessary data is not inserted into the proper drive, 
the Load Disk/Tape Dialog window will appear informing you of which 
disk needs to be inserted into which drive.  
Figure 7-34: Load Disk/Tape Dialog 
Call TCMS Control Room (76629) and ask them to do this for you, then 
select OK. If the disk is still not in the proper drive, the window will 
reappear.  

3. Wait until Retrieval Complete appears in the Retrieval Message Area. 
Figure 7-35: Retrieval Complete 

 

7.3.3. Viewing Processed Data 
Note: Some of these steps concern viewing the data during testing. If 
you are able to view the file in Notepad or a similar program, use only 
step 4. 

1. To view the file containing the processed data, select Rlog in DBS from the 
TCMS main screen. 
Figure 7-36: Rlog in DBS 

2. Making sure the cursor is in the window, enter pwd to confirm that you are in the 
same directory as the data file.  

3. Enter pg filename.txt is to view the data file.  
Figure 7-37: Viewing Data File 

Note: A shortcut is to enter ls –latr to view most recently updated files in 
directory. Select the data file to view, the type pg , making sure to 
include the space after pg. The select with the middle button of the 
mouse and press Enter. Also, to reuse previous commands, press the 
Esc key. Then press the K and J keys to scroll backward and forward, 
respectively, through previous commands. When required command 
found, press Enter to execute. 

4. The data is displayed in a table; the columns are the UTC, M/SID, command 
description, status, and value. The data is only displayed for the times in which 
there is a status or measurement change or a status check, which occur on a 
twenty-minute interval. 
Figure 7-57: Processed Data File 

5. There are several ways to scroll through the document. The enter key scrolls 
forward 16 lines. +### moves forward ### lines, -### moves back ### lines. By 
moving the mouse and holding down with the middle button, it is possible to 
scroll up or down through data already revealed by moving the mouse in that 
respective direction. Entering a forward slash followed by characters (ex. /0A03) 
skips forward to the next occurrence of that sequence of characters. If the first 
occurrence of the sequence is not the required one, entering only a forward slash 
(/) will repeat the search for the same sequence. 
Figure 7-39: Moving in Data File 

6. Enter q to exit viewing file (or press Enter at the end of file). 
Figure 7-40: Exiting Data File 
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7.4. Figures 
 

 

Figure 7-1: TCMS Main Screen > Retrieve Session 

 

Figure 7-2: Retrieval List 

 

Figure 7-3: Retrieval Label Prompt 
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Figure 7-4: Retrieval Session > Test ID 

 

Figure 7-5: Test ID Selection 

 

Figure 7-6: Retrieval Times > All Times 
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Figure 7-7: Retrieval Times 

 

Figure 7-8: Retrieval Message Area 

 

Figure 7-9: UTC Start Time Acceptance 

 

Figure 7-10: UTC Start Time Rejection 
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Figure 7-11: Duration Acceptance 

 

Figure 7-12: UTC Stop Time Acceptance 

 

Figure 7-13: Processed Retrieval Time 

 

Figure 7-14: Retrieval Times > Defined Times 
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Figure 7-15: Defined Times 

 

Figure 7-16: Switching Disks 

 

Figure 7-17: Retrieval Destination 
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Figure 7-18: File Manager 

 

Figure 7-19: Retrieval Definition > Raw-1553 
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Figure 7-20: Raw-1553 Message Retrieval 

 

Figure 7-21: Bus PUI Selection 
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Figure 7-22: Raw-1553 Filter Parameter Definition 
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Figure 7-23: RT Selection in Command Words 

 

Figure 7-24: T/R Selection in Command Words 
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Figure 7-25: Subaddress Selection in Command Words 

 

Figure 7-26: Retrieval Definition Confirmation 

 

Figure 7-27: Retrieval Control > Execute 

 

Figure 7-28: Concurrent/On Queue 
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Figure 7-29: Retrieval Executing 

 

Figure 7-30: Retrieval Control >Abort 

 

Figure 7-31: Abort Retrieval 

 

Figure 7-32: Retrieval Control > Pause 
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Figure 7-33: Retrieval Control > Resume 

 

Figure 7-34: Load Disk/Tape Dialog 

 

Figure 7-35: Retrieval Complete 

 

Figure 7-36: Rlog in DBS 
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Figure 7-37: Viewing Data File 

 

Figure 7-38: Raw-1553 Message Data File 
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Figure 7-39: Moving in Data File 

 

Figure 7-40: Exiting Data File 

 

Figure 7-41: Raw-1553 Telemetry Retrieval 

 
 

Figure 7-42: S-Band Bus PUI Selection 
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Figure 7-43: Raw-1553 Telemetry Formats 

 
 

Figure 7-44: Format ID Selection 
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Figure 7-45: Processing Frame Selection 

 
 

Figure 7-46: Rate Selection 

 
 

Figure 7-47: Start Word Selection 

 
 

Figure 7-48: Number of Words Selection 
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Figure 7-49: Telemetry Data File 

 

Figure 7-50: Retrieval Definition > Proc 
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Figure 7-51: Processed Meas 

 

Figure 7-52: Displaying PUIs with Wildcard 
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Figure 7-53: MSID Error 

 

Figure 7-54: Selecting PUIs with Wildcard 
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Figure 7-55: Selecting PUIs by Manual Entry 

 

Figure 7-56: Deselecting PUIs 
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Figure 7-57: Processed Data File 

Page 86 of 109 



December 19, 2002 at 3:59 PM  

 

7.5. Tables 
 

 

 

Rate (Hz) Format Format Name Start Word 

1 Essential Word Offset + 236 

2 Housekeeping I Word Offset + 188 

0.1 

3 Housekeeping II Word Offset + 56 

1 1 
2 
3 

Essential 
Housekeeping I 
Housekeeping II 

Word Offset + 8 

10 1 
2 
3 

Essential 
Housekeeping I 
Housekeeping II 

N/A 

Table 7-1: Start Word Determination 
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8. PASS-1000 

8.1. Snapshot Mode Retrieval 
1. Select Monitor > Snapshot Mode. 

Figure 8-1: Monitor > Snapshot  Mode  
Figure 8-2: Snapshot Mode Screen  

8.2. Data Logging Mode Retrieval 
1. Select Monitor > Data Logging Mode. 

Figure 8-3: Monitor > Data Logging  Mode  
a. To create new files: Select the Filename text box and enter the required 

filename. There is a seven-character filename limit. The default file extension 
is .arc; however, in the event the file needs to be zipped, change the 
extension to .sbs, as Winzip will think .arc is already zipped. 
Figure 8-4: File Open New File  

b. To view existing files: Select the required directory in the right column. Select 
the required filename in the left column. 
Figure 8-5: File Open Old File  

2. Select OK. 
Figure 8-6: Data Logging Mode Screen  

8.3. Executing Retrieval 
1. Select Log Devices. Select/deselect the Log Devices such that only the required 

Log Devices have a checkmark to their left. 
Figure 8-7: Log Devices  

2. Select Log Filters. Select the required Log Filter. 
Figure 8-8: Log Filters 

3. In the RT Filter Control Panel, the available RTs are displayed. Green highlight of 
an RT means all of the subaddresses in that RT are selected; yellow highlight of 
an RT means some of the subaddresses in that RT are selected; gray highlight of 
an RT means none of the subaddresses in that RT are selected.  
Figure 8-9: RT Filter Control Panel 
a. To select all of the subaddresses for all of the RTs, select All. 
b. To select none of the subaddresses for all of the RTs, select None. 
c. To select all or none of the subaddresses for an individual RT, select the RT 

until it has the respective green or gray highlight.  
d. To individually select/deselect subaddresses for an RT, select Edit from 

beneath that particular RT. In the SA Filter Definition Panel, the available 
subaddresses are displayed in two separate tables: Receive Buffers and 
Transmit Buffers. Green highlight of a subaddresses means it is selected for 
the respective receive or transmit; gray highlight of a subaddresses means it 
is not selected for the respective receive or transmit. 
Figure 8-10: SA Filter Definition Panel 
i. To select all of the subaddresses for both receive and transmit, select All. 
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ii. To select none of the subaddresses for both receive and transmit, select 
None. 

iii. To select/deselect a subaddress, select the subaddress from the 
respective receive or transmit table until it has the respective green or 
gray highlight. 

4. Select Triggers. Select the name of database monitoring below the Simple 
heading.  
Figure 8-11: Trigger > Database 

5. Select the pull down menu and select the trigger required. If no specific trigger 
required, select Trig on any msg for all messages. 
Figure 8-12: Trigger Selection 

6. Select the Filesize text box. Enter the size or greater that you want the file to be 
in bytes. If Stop is selected while the monitoring is occurring, the file size will be 
that of the file at the time Stop is selected. Otherwise, the file size will be that 
which was entered. 
Figure 8-13: Filesize 

7. Select Run.  
Figure 8-14: Monitor Control 

8. To stop the monitoring, select Stop or wait for the buffer. 
9. Scroll to data or use Find.  

8.4. Using Find 
1. Select Find. The search goes down from whatever buffer currently at in the file. 

Figure 8-15: Display 
2. Select type of find. Most commonly used is the Find msg=MSGID when 

MASKed data word NN=VALUE. An explanation of all search types is available 
in Table 3.5.10 of the PASS-1000 Users Manual.  
Figure 8-16: Find 

3. Enter the required MSGID in the four text boxes. Each box respectively 
represents the RT address, whether receiving or transmitting (R/T), the 
subaddress, and the word count (usually 32 words, since most 1553 data in 
Space Station uses the 32 word “boxcar” data transmission). “X” can be used in 
the above fields as a wildcard. If the required subaddress does not have a 
processing frame counter, use a subaddress that has a relevant processing 
frame counter.  

4. Enter the Mask value in hexadecimal. This specifies the value of a mask that will 
be logically anded with the current word. This allows for a bit to be out of sync in 
the bits that are not significant and not interfere. If searching for a processing 
frame, only 0-99 are used, so only the seven least significant bits are used. The 
Mask value would then be 007F. The Mask value FFFF can be used to find all 
bits.  

5. Enter the Value in hexadecimal. This can be a processing frame or other type of 
data word. 

6. Enter the word offset for the data word in NN. 
7. Select OK. 
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Note: To find the next message meeting the search pattern, select Next. 
To find the last message meeting the search pattern, select Last. 
Figure 8-15: Display 
 
 

8.5. Finding Data 
1. The raw data is displayed in sets of data. Each set of data is for an individual 

subaddress for each processing frame. A horizontal line separates the sets of 
data. Each data set has a message number to its left, in the order card:: buffer: 
message number, followed by the gap, absolute, and delta times. 
Figure 8-17: Message Number 

2. If the processing frame counter is not in the subaddress relevant to the PUI, go to 
the relevant subaddress in the same processing frame (if the relevant 
subaddress is greater than the processing frame counter, then the next relevant 
subaddress; if the relevant subaddress less than the processing frame counter, 
then the previous relevant subaddress). 

3. Each set of data for each subaddress for the different times contains 32 words in 
four rows, four characters per word. The first row contains words 1-8; the second 
row contains words 9-16; the third row contains words 17-24; the fourth row 
contains words 25-32. The word offset ranges from 1-32. Find the word 
corresponding to the word offset (e.g. a word offset of 10 would by the second 
word from the left in the second row; a word offset of 30 would by the sixth word 
from the left in the fourth row). If the word order is Intel (only applicable with data 
types of two or four words), the extracted words need to be word swapped. This 
is because Intel transmits the least significant word first instead of the most 
significant word first as required by Mil-Std-1553. Examples: if the extracted 
words are 43ab 78c9, then the data is 78c9 43ab; if the extracted words are 43ab 
78c9 56f4 d12e, then the data is d12e 56f4 43ab 78c9. 

4. Once in the required word, find the first bit of the data for the required PUI. Each 
word contains 16 bits, 4 bits per character. The bits in a word are labeled 0-15. |0 
1 2 3|4 5 6 7|8 9 10 11|12 13 14 15| The bit offset is the first bit in the data. The 
required bit is that labeled bit (ex. if the bit offset is 7, then the first bit is bit 7, 
which is the eighth bit from the left). 

5. Once beginning with required bit, the amount of data corresponding the PUI is 
the data type (ex. if the bit offset is 7 and the data type is 3 bits, then the data 
relevant to the PUI is bits 7-9, the eighth, ninth, and tenth bits from the left).  

8.6. Saving as ASCII file 
1. Select File > Save as ASCII File. 

Figure 8-18: File > Save as ASCII File 
2. If all of the data is in the current buffer, select OK. However, if the required data 

is in more than one buffer, select the diamond next to Message Range. Then 
enter the first and the last messages that you want saved in their respective 
text boxes (message information found to the left of the data sets).  
Figure 8-19: ASCII Save 
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Note: To find the last message in the data set, select Last in the Monitor 
Control Panel. If a Find has been performed before this, select Find and 
enter X for all values and then select Last. 
Figure 8-15: Display 

3. Select the Filename text box and enter the required filename. There is a seven-
character filename limit. Use the extension .txt for text files. Select OK. 
Figure 8-4: File Open New File 

8.7. Monitoring a Subaddress 
1. Select RT > View. 

Figure 8-20: RT > View 
2. Select Sel under the required RT address. 

Figure 8-21: View RT Select 
3. Select Sel under the required subaddress.  

Figure 8-22: View Subaddress Select 
A screen displaying the current 32 words of data for the respective 
subaddress appears. The screen continuously updates itself. 
Figure 8-23: Subaddress Monitoring 

8.8. Monitoring Bus Activity 

8.8.1. Percent Display 
1. Select Bus Activity > Percent Display.  

Figure 8-24: Bus Activity > Percent Display 
A screen displaying a box for each RT address appears. Each RT address 
has a percentage amount (also represented by a bar) next to an R and a T 
(receiving and transmitting data, respectively), representing the percentage of 
the bus’s total activity it is using. The receiving and transmitting percentages 
represent percentage of bus bandwidth. Green means that the MDM is polling 
for and receiving information from the Remote Terminal; yellow means that 
the MDM is polling for the Remote Terminal, but is not getting a response. 
Red means that there is an error on the bus (Parity error, Manchester error, 
etc) and you can left click on the RT to determine the specific errors that are 
being generated. The screen continuously updates itself. 
Figure 8-25: Percent Bus Activity by RT 

2. Hold the Left mouse button on the required RT address. The error summary 
for that RT address appears so long as the Left Mouse button is depressed. 
Figure 8-26: Bus Activity by RT Error summary 

3. Right-click the required RT address. A screen displaying a box for each 
subaddress appears. Each subaddress has a percentage amount (also 
represented by a bar) next to an R and a T (receiving and transmitting data, 
respectively), representing the percentage of the RT address’s total activity it 
is using. The receiving and transmitting percentages represent percentage of 
bus bandwidth. Green means that the MDM is polling for and receiving 
information from the Remote Terminal; yellow means that the MDM is polling 
for the Remote Terminal, but is not getting a response. Red means that there 
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is an error on the bus (Parity error, Manchester error, etc) and you can left 
click on the RT to determine the specific errors that are being generated. The 
screen continuously updates itself. 
Figure 8-27: Bus Activity by Subaddress 
a. Hold the Left Mouse Button on the required subaddress. The error 

summary for that subaddress appears so long as the Left Mouse button is 
depressed. 
Figure 8-28: Bus Activity by Subaddress Error Summary 

b. Right-click anywhere on the screen to return to the screen displaying all 
the RT addresses. 

4. Select OK to close the screen. 

8.8.2. Count Analysis 
1. Select Bus Activity > Count Analysis.  

Figure 8-29: Bus Activity > Count Analysis 
A screen appears with each RT address in a row. In each RT’s row, there is a 
row for the total count of the RT, the A bus, and the B bus; in each column, 
the sum of the A and B bus counts should equal the total count for the RT 
address. There are columns for the Command Count, No Response, Error 
Count, and Error. At the end of each RT row, there is the status word for that 
RT address. The screen continuously updates itself. 
Figure 8-30: Bus Activity by Count 
 
Notes:  
1. If the MDM is out of sync, most MDMs will have the MSB of the first word 

as set; thus PF 1 would be found as “8001”, PF10 would be found as 
“800A”, etc.  Thus the use of Masking in Find. 
 

8.9. Figures 
 

 

Figure 8-1: Monitor > Snapshot  Mode 
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Figure 8-2: Snapshot Mode Screen 

 

Figure 8-3: Monitor > Data Logging  Mode 

 

Figure 8-4: File Open New File 
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Figure 8-5: File Open Old File 

 

Figure 8-6: Data Logging Mode Screen 

 

Figure 8-7: Log Devices 
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Figure 8-8: Log Filters 

 

Figure 8-9: RT Filter Control Panel 

 

Figure 8-10: SA Filter Definition Panel 

Page 95 of 109 



December 19, 2002 at 3:59 PM  

 

Figure 8-11: Trigger > Database 

 

Figure 8-12: Trigger Selection 

 

Figure 8-13: Filesize 

 

Figure 8-14: Monitor Control 
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Figure 8-15: Display 

 

Figure 8-16: Find 

 
 

Figure 8-17: Message Number 
 

 

Figure 8-18: File > Save as ASCII File 
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Figure 8-19: ASCII Save 

  

Figure 8-20: RT > View 

 

Figure 8-21: View RT Select 
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Figure 8-22: View Subaddress Select 

 

Figure 8-23: Subaddress Monitoring 

 

Figure 8-24: Bus Activity > Percent Display 
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Figure 8-25: Percent Bus Activity by RT 
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Figure 8-26: Bus Activity by RT Error summary 
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Figure 8-27: Bus Activity by Subaddress 
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Figure 8-28: Bus Activity by Subaddress Error Summary 

 

Figure 8-29: Bus Activity > Count Analysis 
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Figure 8-30: Bus Analysis by Count 
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Appendix G PASS-1000 Sources 
PASS-1000 Users Manual 
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Retrieval to PASS-1000 Conversion Instructions 
 

Appendix H Acronym List 
A/D Analog to Digital 
A/L Airlock 
ABC Audio Bus Coupler 
ACBSP Assembly Contingency Baseband Signal Processor 
ADD Architecture Design Document 
AIO Analog Input Output 
AP Application Processor 
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AP Attached Payload 
APID Application Identifier 
APM Advanced Pressurized Module 
APS Automated Payload Switch 
ASCR Assured Safe Crew Return 
ATU Audio Terminal Unit 
BAD Broadcast Ancillary Data 
BED BAD EXT Data 
BC Bus Controller 
BIA Bus Interface Adapter 
BM Bus Monitor 
BPUI Bus PUI 
C&C Command and Control 
C&DH Command and Data Handling 
C&T Communication and Tracking 
C&W Caution and Warning 
CCSDS  Consultive Committee for Space Data Systems 
CDD Command Description Document 
CM Configuration Management 
CMSG_CON Command 1553 Message Content 
COTS Commercial Off the Shelf 
CPUI Conversion PUI 
CSCI Computer Software Control Interface 
DDCU DC to DC Converter Unit 
DIO Discrete Input Output 
DIU Data Interface Unit 
DP Data Package/Processing 
DPUI Device PUI 
DRAM Dynamic Random Access Memory 
ECLSS Environmental Control and Life Support System 
EEPROM Electrically Erasable Programmable Read-Only Memory 
EHS Enhanced HOSC System 
EIOCU Enhanced Input/Output Control Unit 
EPS Electrical Power System 

Enhanced  
EVA Extra Vehicular Activity 
EXPRESS EXpediting the Process of Experiments to the Space 

Station 
EXT External 
FC Firmware Controller 
FDS Flight Design Systems 
FEP Front-End Processor 
FEU Flight Equivalent Unit 
FGB Functional Cargo Block (Functionalui Germaticheskii 

Block) 

ESS 
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FQT Formal Qualification Test 
FSW Flight Software 
FWC Firmware Controller 
GMT Greenwich Mean Time 
GN&C Guidance, Navigation, and Control 
GSE Ground Support Equipment 
H/W Hardware 
HLA High Level Analog 
HOSC Huntsville Operations Support Center 
HRDL High Rate Data Link 
HRF Human Research Facility 
HRFM High-Rate Frame Multiplexer 
HRM High Rate Modem 
I/F Interface 
I/O Input/Output 
IAC Integrated Assembly & Checkout 
ICD Interface Control Document 
IFL Integrated Flight Load 
INT Internal 
IOCU Input/Output Control Unit 
IP International Partner 
IP&CL Instrumentation Program and Command List 
ISIL ISS System Integration Lab 
ISRP International Standard Payload Rack 
ISS International Space Station 
JCS Johnson Space Center 
JEM Japanese Experiment Module 
KSC Kennedy Space Center 
Ku Frequency Sub-Band 
LA Lab 
LAN Local Area Network 
LB Local Bus 
LIF Load Image Format 
LLA Low Level Analog 
LRDL Low Rate Data Link 
MATE MDM Application Test Environment 
MBF Mission Build Facility 
Mbps Mega bit per second 
MCC-H Mission Control Center-Houston 
MCC-M Mission Control Center-Moscow 
MDM Multiplexer/Demultiplexer 
MEIT Multiple Element Integration Test 
Mil-Std 1553 Military-Standard 1553 
MIP Minimum Impulse Pulse 
MPLM Multi-Purpose Logistics Module 
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MRDL Medium Rate Data Link 
MSD Mass Storage Device 
MSFC Marshall Space Flight Center 
Msg Ref Message Reference 
Msg Ret Message Retrieval 
MSID Measurement Stimulus ID 
MSS Mobile Servicing System 
N# Node # 
O&M Operations and Maintenance 
OIU Orbiter Interface Unit 
OPF Orbiter Processing Facility 
Ops Operations 
PASS Protocol Analysis and Simulator System 
PCR Portable Computer Receptacle 
PCS Portable Computer System 
PD Payload Developers 
PDA Packet Data Analyzer 
PDG Payload Data Generator 
PDDS Payload Data Services System 
PEHG Payload Ethernet Hub Gateway 
PI Payload Integrators 
PL Payload 
PMA Pressurized Mating Adapter 
PMCU Power Management Controller Unit 
POIC Payload Operations Integration Center 
PPL Pre Positioned Load 
PRCU Payload Rack Checkout Unit 
PSAD Payload Specific Ancillary Data 
PSPF Prime Software Production Facility 
PTCS Payload Test and Checkout System 
PUI Project Unique Identifier 
PVCU  Photovoltaic Controller Unit 
pwd Present working directory 
q Quit 
R&R Resupply and Return 
RAM Random Access Memory 
RF Radio Frequency 
RFCT Ready for Combined Training 
RJ Rotary Joint 
RPCM Remote Power Controller Module 
RPUI Requirement PUI 
RSA Russian Space Agency 
R/T Receiver/Transmitter 
RT Remote Terminal 
RTD Resistive Temperature Device 
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RWS Remote Workstation 
SCU Sync Control Unit 
SDIL Software Development and Integration Lab 
SDO Solenoid Driver Output 
SM Service Module 
SPD Serial/Parallel Digital 
SPUI Signal PUI 
SRD Software Requirements Document 
SSCC Space Station Control Center 
SSCS Space to Space Communication System 
SSTF Space Station Training Facility 
STD OUT Standard Out 
SVF Software Verification Facility 
SW Software 
Sync Synchronization signal 
TBD To Be Determined 
TCS Thermal Control System 
TCMS Test, Control, and Monitor System 
TDD Telemetry Description Document 
TDRSS Tracking and Data Relay Satellite System 
Tlm Telemetry 
Tlm Ret Telemetry Retrieval 
TRR Test Ready Release 
UAS User Application Software 
UHF Ultra High Frequency (system) 
USAF United States Air Force  
USICU United States ISPR Check-out Unit 
USL United States Lab 
USOS United States On-orbit Segment 
UTC Coordinate Universal Time 
VAB Vehicle Assembly Building 
VBSP Video Baseband Signal Processor 
VDD Version Description Document 
VSU Video Switch Unit 
WD Word 
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